
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 

 

 

 

  

PROJECT DELIVERY SYSTEM (PDS) TRAINING 
SECTION 01 - OVERVIEW 

RELEASE DATE: 09-APR-2020 



CU Boulder 
PDS Help Files 

Section 01 – Unifier Overview 
Release Date: 4/9/2020 

 

 Page 2 of 39  

REVISION TRACKING 

 

Revision Author(s) Approved By Issue Date Reason 

v3-0 Sage Method  3/12/2020 Unifier Go Live Mar 2020  

v3-1 Sage Method  4/3/2020 Final Updates 

v3-2 Sage Method K. Dunklau 4/9/2020 Updates to document manager section. 

 

 

  



CU Boulder 
PDS Help Files 

Section 01 – Unifier Overview 
Release Date: 4/9/2020 

 

 Page 3 of 39  

TABLE OF CONTENTS 

 

REVISION TRACKING ......................................................................................................................................... 2 

1.0 UNIFIER OVERVIEW .................................................................................................................................... 4 

1.0.1 Introduction ........................................................................................................................................ 4 

1.1 GENERAL TASKS AND ADMINISTRATION .................................................................................................... 5 

1.1.0 Introduction ........................................................................................................................................ 5 
1.1.1 Logging In / Out of Unifier (Updated: 4/2/2020) .............................................................................. 6 
1.1.2 Setting Preferences (Updated: 10/24/2019) ..................................................................................... 9 
1.1.3 Setting Bookmarks (Updated: 10/24/2019) .................................................................................... 14 
1.1.4 Navigating the Project (Updated: 11/12/2019) ............................................................................... 16 
1.1.5 Completing Tasks, Viewing Messages, and Viewing Drafts in Unifier (Updated: 4/2/2020) ..... 19 
1.1.6 Determining Workflow Progress (Updated: 4/2/2020) .................................................................. 25 
1.1.7 Utilizing Form Functionality (Updated: 4/2/20) ............................................................................. 27 
1.1.8 Working with Line Items (Updated: 10/24/2019) ........................................................................... 31 

1.2 DOCUMENT MANAGEMENT ..................................................................................................................... 34 

1.2.0 Introduction (Updated: 4/9/2020) .................................................................................................... 34 
1.2.1 Viewing Document Structure, Permissions and Control (Updated: 4/9/2020) ........................... 36 
1.2.2 Uploading Documents and Naming Conventions (Updated: 4/9/2020) ...................................... 38 

 

Disclaimer 
This document and its contents have been prepared and are intended solely for the UCB PDS 
system, Oracle Unifier, for the purposes of learning how to use the system.  CU Boulder and Sage 
Method assume no responsibility to any other party in respect of or arising out of or in connection 
with this document and/or its contents. 

Copyright 
The copyright of this document is vested in CU Boulder and Sage Method.  This document may 
not be reproduced in whole or in part without their express written permission.  

  



CU Boulder 
PDS Help Files 

Section 01 – Unifier Overview 
Release Date: 4/9/2020 

 

 Page 4 of 39  

1.0 UNIFIER OVERVIEW 

1.0.1 INTRODUCTION 

The UCB PDS project was undertaken in January 2018 after a process of software and vendor selection. 
Oracle Unifier will replace the Capital Projects module of FAMIS. As of December 2019, all new Request 
Applications will be completed in Unifier. Project will be managed there until Financial Closeout. FAMIS 
Capital Projects module will be retired when all projects are closed out in FAMIS.  

The system will support previous efforts of process definition and lifecycle management for campus 
construction projects. The system will: 

1. Enable efficient project management planning and execution from start to finish to allow for 
enhanced customer service. 

2. Decrease in entering duplicate information.  

3. Enable easier reporting. 

4. Create one source of planning and project data.  

5. Enable system of record for planning and project information during the life of the project. 

6. Replace a portion of the existing system. (Capital Projects module of FAMIS) 

7. Reduce time to decision.  

8. Increase transparency and visibility into timely information to facilitate key metric measuring and 
reporting. 

9. Facilitate continuous improvement in processes.  

10. Support proactive management. 
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1.1 GENERAL TASKS AND ADMINISTRATION 

1.1.0 INTRODUCTION 

General tasks and administration help with navigating Unifier and using features that are repeated 
throughout the system. This section will enable you to understand Unifier basics so that when you start 
learning the specific processes, the system functionality is familiar.  
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1.1.1 LOGGING IN / OUT OF UNIFIER (UPDATED: 4/2/2020) 

 

Goals How to log in and out of Unifier and what you will see 

Navigation Unifier Log In Screen 

Action By All Users 

Pre-requisites UCB username and password 

Related Files None 

 

Action By: All Users Example 

1. Navigate to the provided URL using 
Chrome (other browsers cause 
functional issues).  

2. If you are a UCB employee, your 
single sign on will redirect you to the 
single sign on screen. 

Note: If a pop-up blocker appears, 
configure your browser to always 
allow pop-up windows from this site.  

3. Should you forget your password or 
otherwise experience difficulties 
logging in, please contact the UCB 
Office of Technology Help Desk 
https://oit.colorado.edu/tutorial/identik
ey-manager-forgot-my-identikey-
password or call 303-735-4357 (5-
HELP). 
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Action By: All Users Example 

4. A successful login will display Unifier 
in a new window.  

5. Select the “U” icon to enter Unifier.  

 

6. Once logged in, Unifier will default to 
your Home screen (if you logged out 
on this screen).  

7. If initial login and setup is completed, 
skip to: 1.1.4 Navigating the Project 

Note: Once tabs and preferences are 
set, these will appear each time you 
login (as long as you use the sign out 
button.) 
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Action By: All Users Example 

8. Select “Tasks” in the left-hand menu 
to access all tasks across all projects. 

9. Select “Drafts” in the left-hand menu 
to access all drafts across all projects. 

Note: Any form with a workflow that is 
saved and closed without sending will 
only be available to the user who 
saved it in their drafts. 

Note: Tasks and Drafts are also 
accessible within project shells under 
Project –Task Manager>Tasks / 
Drafts. (Where “project” is the actual 
name of your project.) 

Note: Selecting an item from the 
“Tasks or Drafts” log will take you to 
the record.  

10. Selecting a task or mail item will open 
it in a new window. 

 

11. To create a project tab, select the “+” 
icon along the top, like opening a new 
browser window.  

12. To find a specific project, search for 
your project name.   

Note: You will only be able to see 
items you have permissions to. If you 
can’t see something, please contact 
your Project Coordinator to validate 
your permission settings. 

 

13. Navigate to the Home Tab. 

         

14. When logging out of Unifier, select 
your name and then the “Sign Out” 
link instead of using the browsers “X” 
button. You must then close the 
browser window, not just the browser 
tab. This officially ends your session 
on the server. 

Note:  it is recommended practice to 
be on the Home tab screen before 
logging out. 

  

 
END TASK 
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1.1.2 SETTING PREFERENCES (UPDATED: 10/24/2019) 

 

Goals How to set preferences, proxy, etc. per user. 

Navigation Home Screen 

Action By All Users 

Pre-requisites Logging In / Signing Out of Unifier 

Related Files None 

 

Action By: All Users Example 

1. In Unifier, select your name and then 
“Preferences” to open the User 
Preferences screen.  

Note: When you log in for the first 
time, it is important to check and set 
your preferences. 

 

2. In the General tab, confirm your 
details. 

3. Double-click on the graphic to open 
the window to update your profile 
picture.  

4. Follow instructions and select “Save”. 

5. Select “Apply” to accept any changes; 
then select “OK.” 
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Action By: All Users Example 

6. Select the “Region Format” Tab 

7. In the lower left confirm your time 
zone, language, and date format.  

8. In the lower right confirm your number 
and currency formats. 

a. Ensure “Show Currency Symbol” 
is checked. 

b. Negative Currency Format to be 
(#123). Do not use other options. 

c. Negative Number Format to be 
(123). Do not use other options. 

Note: The greyed-out box to the far 
right is an example of the number and 
currency formats shown in step 8. 

 

9. Select to “Email Subscription” tab. 

10. Set your email subscriptions.  

Note: Contact your administrator if 
you have any questions on the 
settings. 

Note: The goal is to login to Unifier to 
access project information rather than 
via individual emails.  

Note: Do not modify anything in the 
first column.  

11. Select “Apply” to accept any changes; 
then select “OK.” 

 



CU Boulder 
PDS Help Files 

Section 01 – Unifier Overview 
Release Date: 4/9/2020 

 

 Page 11 of 39  

Action By: All Users Example 

12. Select the “Proxy” Tab. 

a. In “My Proxy” you can add, 
modify, or remove a proxy. 

b. In “I am Proxy” is the list of 
available users for whom you can 
function as their proxy. 

c. In “Proxy Login History” is the 
history of proxy logins. For 
example, the Name, Login Date, 
and Logout Date of the Proxy. 

Note: Do Not Allow Proxies option is 
only available for Site/Company 
Administrators, Company users and 
Partner users, otherwise seen as 
read-only. 

Note: A proxy is someone who can 
perform tasks in Unifier on your 
behalf. This also includes records that 
have been created by the you. Any 
actions completed by the proxy will 
appear in the Audit logs. 

Note: An assigned proxy will have 
access to all of your projects. You 
cannot select different proxies for 
different projects. You can assign two 
or more proxies to allow a different 
proxy to work on a particular project.  

 

13. Add a user who can act as your proxy 
by: 

a. Select “+” (Add). 

b. Under “Grant Proxy Access To”, 
select a user to act as your proxy. 

c. Enter the Start Date/Time and 
End Date/Time that you can allow 
a proxy user access to your 
account, for example start and 
end dates of your vacation. Or, 
you can select Active/Inactive. 

Note:  Time defaults to 5 PM. 
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Action By: All Users Example 

14. Proxy Users whose status is set to 
Active will receive email notifications 
of tasks that need to be completed. 
Use Inactive to disable a proxy’s 
access. 

 

 

15. Select “OK”. 

16. Select “Apply” and then “OK”. 

Note: You must select “Apply” after 
setting a user as your proxy or the 
user will not be added as your proxy. 

Note: You can have more than one 
user added as your proxy. 

Note: If you are unable to add a user 
as a proxy, your System Administrator 
can assign users on your behalf. 

 

17. Select “OK” to close the user 
preferences screen. 

 

18. To login as someone else’s proxy 
user: 

a. Select “Username” to drop down 
the contextual menu.  

b. Open “Proxy For” to show a list of 
users who designated you as their 
proxy. 

c. Select a user to act as proxy for. 
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Action By: All Users Example 

19. The user appears in right upper 
corner as “Proxy for User Name”. At 
this point you can now perform 
functions and tasks via the selected 
user.  

20. Select the pull down the contextual 
menu in the username and select 
“Sign Out”. 

21. You will be returned to your user 
page. 

 

22. Select the “More” tab. 

a. Use this tab to configure settings 
such as the view options, view 
exceptions, and default login view. 

23. “Default View” contains Native and 
Unifier Viewer. This determines how 
Unifier displays files that are attached 
to business processes in the 
Document Manager. This can be 
documents, drawings, or images. 

Note:  Native means the document 
will open using its program, such as 
Word or Excel. 

24. Viewer Exception lets the user 
specify which extensions to use which 
viewer. For example, you may have 
Native as your default viewer but want 
to use Unifier Viewer for some file 
types such as adding graphical 
markups and text comments. You 
would type the extension in the 
“Always Use Unifier:” field. 

25. Select “Apply” and “OK”. 

 

 
END TASK 

  

Do not check 
this box.  
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1.1.3 SETTING BOOKMARKS (UPDATED: 10/24/2019) 

 

Goals How to set bookmarks for projects or specific views. 

Navigation Home Screen 

Action By All Users 

Pre-requisites Logging In / Signing Out of Unifier 

Related Files None 

 

Action By: All Users Example 

1. Bookmarks are a useful functionality 
that allows fast and efficient 
navigation between projects. 

Note: This is a helpful alternative to 
creating tabs across the top, 
especially when you have a lot of 
projects. 

2. Navigate to the screen you would like 
to bookmark, for example: a project 
home screen. 

3. Select the star in the upper right-hand 
corner of the screen. 

 

4. Select “Add” to add the project to your 
bookmarks. 

Note: Unifier does not validate 
bookmark names so be aware of 
creating duplicates and use clear 
naming conventions. 

Note: You cannot add bookmarks in 
admin mode. 

Note: A bookmark is based on a 
user’s permissions. For example, if 
you do not have access to a module, 
Unifier will display the Home page. If 
you do have access it will open the 
shell or project. 

 

5. To see your bookmarks, Select on 
the “star.” 

 

6. You may also rearrange bookmarks. 
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Action By: All Users Example 

7. Select a bookmark to modify by 
Selecting on the gear by the name. 

8. Select “Remove”, “Move Up”, or 
“Move Down”, as necessary. 

Note: The checkbox is only used for 
setting the default login; for other 
actions, select the bookmark by 
Selecting on the name. 

 

9. Select outside of the bookmarks drop 
down to exit the bookmarks screen. 

 
END TASK 
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1.1.4 NAVIGATING THE PROJECT (UPDATED: 11/12/2019) 

 

Goals How to navigate through Unifier at a high level including finding the "help", 
search and tab functionality. 

Navigation Home Screen 

Action By All Users 

Pre-requisites Logging In / Signing Out of Unifier 

Related Files None 

 

Action By: All Users Example 

1. If this is the first time you have logged 
in, the screen will default to your 
home screen.  

2. The home screen allows you to view 
your “tasks” list across all projects.   

 

3. To find your project, search your 
bookmarks, Select on a project tab, 
or find the project using the “+” to the 
left of your home screen; like opening 
a new browser window. 

 

4. By default, the screen will open to the 
last screen you were on prior to 
selecting “Sign Out”. If it is the first 
time you have visited this project, it 
will default to the Home screen where 
the dashboards are visible. 
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Action By: All Users Example 

5. To add or change an image, access 
the drop-down menu on the project 
dashboard. 

Note: Adding or changing an image, 
can only be performed by the Project 
Coordinator, Project Manager or 
Project Planner. 

6. Select “Details” 

 

7. In the “Images” tab select an image 
by using “Browse” or “Document. 
Manager” from the drop-down. 

 

8. The selected file name will appear. 

9. Select Upload to add the image to 
the project dashboard. 
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Action By: All Users Example 

10. Business processes are forms or 
workflows that are created as part of 
the project. They are listed down the 
left side of the screen.  

Note: This may look different 
depending on your permissions.  

11. To open business processes, or BP’s, 
select the “+” on any of the modules 
located on the left side of the screen 
to expand the selection.  Conversely, 
select “-” to collapse. 

12. To find generic Help at any time, use 
the “?” in the upper right corner of the 
screen. 

 

13. To find help for specific business 
processes, select the “?” from within 
the process screen and select the 
help file for that specific process.  

Note: User Productivity Kit is not 
available for selection.  

 

 END TASK 
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1.1.5 COMPLETING TASKS, VIEWING MESSAGES, AND VIEWING DRAFTS IN UNIFIER 
(UPDATED: 4/2/2020) 

 

Goals Shows how to view, accept, and respond to tasks in Unifier 

Navigation Home Screen 

Action By All Users 

Pre-requisites Logging In / Signing Out of Unifier 

Related Files None 

 

Action By: All Users Example 

1. Navigate to the Home screen within 
Unifier.  

2. The home screen allows you to view 
your “to do” list across all projects.  

Note: Tasks, Messages, and Drafts are 
also accessible within project shells 
under Project – >Tasks Drafts.  

3. Select “Tasks” in the left-hand menu to 
access all tasks across all projects. 

Note: Tasks, Messages, and Drafts are 
also accessible within project shells 
under Project – Home> Tasks / Drafts. 

Note: Selecting a task or mail item will 
open it in a new window. 
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Action By: All Users Example 

4. Select the relevant task from the list, via 
two options:  

a. Double-Select (step 5) to open or  

b. Highlight and Accept (step 6). 

Note: To assist in locating a task, pay 
special attention to the column headings 
“Origin”, “Business Process”, and “Sent 
for”; you may also utilize the “Find” and 
Filtered By” features. 

Note: All fields are view-only before the 
task is accepted. 

 

5. Double-click the task. 

a. The form opens in a new window. 

b. Select “Accept” in the upper right 
corner.  

6. Select the task by highlighting it: 

a. Select “Accept Task” from the 
“Action” drop down list which allows 
you to take action on the task (e.g. 
approve, revise, or cancel). Do not 
select “Decline Task” or you will not 
be able to action the task.  The 
Decline Task functionality is not 
being utilized at this time. 

b. This step does not open the task in a 
window. 

7. Once the task has been accepted, any 
required or editable fields will become 
available for entry. Enter data as 
needed.  

Note: You can undo accept if another 
recipient should complete the task 
instead. 

8. Required fields will have a red asterisk 
adjacent to the field.  

9. Editable fields will be white and read-
only fields will appear gray. 

Note: Dependent on the business 
process, there may be no fields available 
for entry. 
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Action By: All Users Example 

10. In the upper right corner select “Send”, 
a new screen will appear called 
Workflow Action Details.  

 

11. Select the appropriate workflow action 
from the options provided in the pull-
down menu. 

Note: The To section shows all the 
users/groups being assigned the next 
portion of the task. 

a. If the task allows for additional 
recipients or selection of the 
recipients, the To and CC fields will 
appear.  

12. Select “Send”. 

 

13. If a validation was not met or a required 
field left blank on the form, then an error 
will appear when attempting to select 
“Send”. 

14. Complete all required fields on the form 
to send the record along the workflow.  

15. Once the task has been completed, the 
record can still be viewed in its 
respective business process, in the 
project, in a read-only format. 



CU Boulder 
PDS Help Files 

Section 01 – Unifier Overview 
Release Date: 4/9/2020 

 

 Page 22 of 39  

Action By: All Users Example 

16. To access mail for all projects, when in 
the Home screen, Select “Inbox” icon. 

17. Select the relevant message from the 
list. 

18. Double-Select the selected email. 

19. The form opens. 

20. Messages can also be flagged for 
importance or review. In the Flag 
dropdown you can select an action. For 
example, ‘call’ or ‘for your information’. 

Note: It is good practice to edit the 
subject line to be something more 
appropriate 

21. When in a project, Select “Mailbox” in 
the left-hand menu to access messages.  

22. Select the relevant message from the 
list. 

23. Double-click the selected email to open 
the form.  

24. View the record information and select 
“Close Window” (the x) when completed.  
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Action By: All Users Example 

25. To compose a message, select the Inbox 
Mailbox folder.  

26. Select New and choose your recipients 
for the following fields: To (the Select 
User list will appear), CC, External CC 
field, and BCC. 

27. Flag a message for follow-up by 
Selecting the Flag button. 

Note: Messages can be sent to and 
received from external (non-Unifier 
users). However, to send messages 
back, they must be added to the 
allowable email list. Contact your Project 
Coordinator for more information.  

 

28. To respond to a message, double-click 
to open and select Reply.  

29. If you want to send to all users in the 
message chain, select Reply All.  

30. To forward a message, select Forward.  

Note: It is good practice to edit the 
subject line to be something more 
appropriate. 

 

31. After one of these three options (steps 
26, 27, or 28) is selected you can Flag a 
message for follow-up by Selecting the 
Flag button. A new window will appear 
and, in the Flag to field you can select an 
action. For example, ‘call’ or ‘for your 
information’. 

Note: Mailbox messages can be linked 
directly to related business process 
records. Any file attachments will remain 
on forwarded messages.  

32. To send an email directly from that 
business process, open the record that 
you would like to send.  

33. From the upper menu button, select 
Email as Attachment to initiate an email 
directly.  

Note: It is good practice to edit the 
subject line to be something more 
appropriate. 
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Action By: All Users Example 

34. Being copied on a record or email is also 
possible.  

35. When you are listed on the CC line of a 
record in workflow your copy will appear 
as notifications on the project Home 
screen and under Inbox. 

 

36. To find a business process record that 
started and saved but not “published” 
using Submit, select “Drafts” in the left-
hand menu to access all draft records 
across all projects. 

37. Select the relevant draft from the list. 

38. Select “Open” from the options at the top; 
alternatively, double-Select the task. 

39. The form opens. 

40. Enter the required record information and 
select a workflow action and select 
“Send: when completed. 

Note: When you save a record before 
sending it to the next step in workflow, it 
will be shown in Drafts.  Once the draft is 
completed and sent, or deleted, it will be 
removed from the list. 

 

 END TASK 
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1.1.6 DETERMINING WORKFLOW PROGRESS (UPDATED: 4/2/2020) 

 

Goals How to look at a workflow and the progress. 

Navigation Home Screen 

Action By All Users 

Pre-requisites Logging In / Signing Out of Unifier 

Related Files None 

 

Action By: All Users Example 

1. View the workflow progress or Audit 
log at any point to see information 
about that record and how it was 
approved or changed over time.  

 

2. Navigate to the record in question by 
selecting from the task list in either 
Home or in the project task screen.  

3. Open the record.   

 

4. On the right menu bar of the open 
record, scroll to the right until you 
see “Workflow Progress” and select. 

 

5. The Log shows all workflow steps, 
who they were sent to, their status 
and the date of the action.  

a. If the task was sent to multiple 
people and one has accepted the 
task, it will show In Progress for 
the person responsible and a 
status of Locked for others.  

6. Select “View Graphic…”, a new 
window appears. 

  

Rt hand menu 

Log 
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Action By: All Users Example 

7. The new window displays 
diagrammatical presentation of the 
workflow with the current workflow 
step highlighted in yellow and a bold 
border.  

8. Close the record. 

 

 END TASK 
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1.1.7 UTILIZING FORM FUNCTIONALITY (UPDATED: 4/2/20) 

 

Goals Shows how to attach documents to records/line items and add General 
Comments across all BPs in Unifier. 

Navigation Home Screen 

Action By All Users 

Pre-requisites Logging In / Signing Out of Unifier 

Related Files None 

 

Action By: All Users Example 

1. Forms have a consistent look and feel 
across all processes once you know 
what to look for.  

2. The left panel contains the form 
information. The ability to edit a field 
will change depending on which step 
a business process resides.  

3. The right panel of every record will 
provide consistent interaction by the 
User via “Attachments”, “Comments”, 
etc. 

4. Navigate to the record in question.  

5. Open the record.   

6. To Add general comments by 
selecting the “Comments” tab in the 
right pane. 
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Action By: All Users Example 

7. Select “Add” (or type in the 
comments box depending on the BP 
type) enter comments and select 
“Post”. 

 

Note:  Adding Comments at the 
creation step will include a “Hide” 
check box.  By default, the box is 
checked and would need to be 
unchecked by the user if they want 
comments to be seen at the next 
step.  Before sending the record to 
the next step in the business 
workflow, you can edit a comment or 
uncheck by ‘Hide’ box, by right-
clicking on the pencil icon and 
selecting edit. Checking or 
unchecking the “Hide” box will not 
influence the rest of the comments in 
following steps. 

 

8. Comments show below the comment 
entry screen.  

Note: Enter thorough comments that 
are meaningful to the other readers.  

Note: Comments are not “threaded.” 

Notes: Comments can be filtered by 
commenter.  

 



CU Boulder 
PDS Help Files 

Section 01 – Unifier Overview 
Release Date: 4/9/2020 

 

 Page 29 of 39  

Action By: All Users Example 

9. While in Comments, can Add 
attachments by selecting the 
paperclip under the comment box and 
selecting “Browse” for local files. 

Note: Attachments can only be added 
in this manner to records that are not 
in terminal status (closed / approved); 
please see Step Error! Reference 
source not found. to add 
attachments to closed records, by 
using General Comments. 

10. Select “Browse” to locate a file to 
attach. 

11. Select additional files to add multiple 
attachments, repeat as necessary. 

12. Add a Document Title, Rev. No, and 
Issue Date to attachments. 

13. Select the file and Select “Open”. 
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Action By: All Users Example 

14. Verify the file uploaded successfully. 

15. Select “Upload” to add the file to your 
comment 

Note: see help file section 1.2.3 on 
naming conventions. 

 

16. Select “Post”. 

 

 END TASK 
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1.1.8 WORKING WITH LINE ITEMS (UPDATED: 10/24/2019) 

 

Goals How to tell if a form has "line items" and how they would be used. 

Navigation Home Screen 

Action By All Users 

Pre-requisites Logging In / Signing Out of Unifier 

Related Files None 

 

Action By: All Users Example 

1. When in an Action Form, Line Items 
can be cost related or not. They 
appear to the right of the main form in 
the left panel of the screen. 

2. Navigate to the record in question. 
For this example, we will use a 
Professional Agreement.  

3. Open the record.  The record opens 
in “Form” view. 

 

4. Select the line item e.g. Cost Line 
Item link to open.  

5. Select a line item to see a preview in 
the right panel of the screen.  

6. Double Select to open a line item to 
edit.  

Note:  The ability to edit a line item is 
not available in all steps of a business 
process. 

 

7. The grid icon opens “Grid” view, 
which allows line items to be added or 
edited in large quantities. 
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Action By: All Users Example 

8. Select Add to enter new items. 

Note: It is easier to add items in the 
“Form” view. 

9. Edit entered items in the grid as 
necessary. 

Note: It is easier to edit multiple items 
in the grid view.  

 

10. Copy line items to limit data entry. 
Select the gear icon next to selected 
line item to access Copy. 

11. Remove items as necessary.  Select 
the gear icon next to selected line 
item to access Remove. 

 
 

12. Select Error Check to ensure all 
required fields are entered. 

13. Select Save to save the grid view.  

Note: Note columns marked with an 
(*) in the grid as these are required 
fields. 

 

14. It is also possible to import line items 
from a *.csv file type. If the business 
process allows it, the template will be 
enabled. 

15. Within the record, Select the line 
series in the upper right corner and 
Export Line Item Template, a new 
window will open. 

Note: If there is no indicator for 
exporting a template, this process has 
not been configured for import. 
Contact your System Administrator if 
you think this is an error.  
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Action By: All Users Example 

16. Select “Open” in the new window, 
this opens the line item template in 
excel. 

Note: Depending on your browser it 
will download to a different location 
and/or appear in the browser window, 
like other downloaded files. 

 

17. Enter all line items into the template 
and save the file in the Unifier 
document manager. 

18. Enter “D” (without quotes) under the 
column labeled D and “Line Items” 
(without quotes) under the column 
labeled Tab Name; these are required 
for import.  

Note: Note the required fields for the 
line item (as noted in the line item 
window) in addition to columns 
labeled D and Tab Name. 

Note: Do NOT change the layout of 
the template as this will generate 
errors. 

Note: “Line Items” may be named 
differently in different business 
processes; please see the tab the 
detail form, for the particular business 
process used. 

 

19. Select “Import” from the Line Items 
portion of the record, this opens a 
new window. 

20. Select “Browse” and locate the file 
you saved in the previous step. 

21. Select “Open” 

22. Select “OK” 

23. This will import the line items into the 
record. 

Note: If there are any errors during 
import download the import errors for 
reference, fix the errors in the file, and 
import again. 

 

 

 END TASK 
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1.2 DOCUMENT MANAGEMENT 

1.2.0 INTRODUCTION (UPDATED: 4/9/2020) 

Saving Documents in Unifier 

Saving documents in Unifier projects can happen in many different ways: 

1. The document is created by the business process record creation.  This is the case for many 
things like contracts and amendments.  The caveat here is that while Mike Turman and the 
working contracts group are working on the changes to these documents with OSA, the data 
needs to be entered into Unifier but the template from Meridian must be used for routing these 
forms.  There is no change to the Meridian process.  The template is copied to the project in 
Meridian and then uploaded to the record in Unifier.  When all changes with OSA are made and 
the custom prints in Unifier updated to reflect those changes, the document will be generated out 
of the business process and saved to the document manager in Unifier automatically.   

2. The document is uploaded to a business process record.  This happens when the data is entered 
into the business process record in Unifier but the document is not generated automatically.  This 
happens in cases like design review.  In these cases, the document can be saved to either Unifier 
or Meridian and then attached to the record from there (or dragged from an email).  If it’s saved to 
Unifier, the process is outlined in the help files.  Also, if this occurs, the document will have to be 
named using the same file suffix as Meridian.  This naming convention is included in the help file.  
There is no change to the Meridian process.   

3. If the document is not part of a business process but just part of the project, it can be saved to the 
document manager in Unifier or Meridian.  If saved to Unifier, the process is outlined in the help 
file.  There is no change to the Meridian process. 

Editing Documents in Unifier 

It is true that documents cannot be edited in the Unifier document manager and relies on native 
applications e.g. Word to update.  While Unifier is a powerful tool for project management workflow and 
data, it is not a sufficient document manager for UCB.  If a document in Unifier needs to be edited, there 
are a couple of ways to do it: 

1. Download the document, edit it, re-upload it to the Unifier document manager as a new revision. 

2. Download the document, edit it, upload as a new document. 

3. Edit the document in Meridian.  There is no change to the Meridian process of vertical versioning. 

About Viewing Documents 

Viewing Unifier projects happens in multiple ways also: 

1. Viewing records and projects in Unifier is permissions based.  Managers and Team Leads do 
have permissions to view everything on any project.  Others have different permissions.  For 
example, project managers and coordinators can only view projects (including all project records) 
they are working on directly.  In order to view a project, you must be added to the project.  
Managers and Team Leads are part of a group “View All” and are automatically added to every 
project. 
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2. Viewing documents in Unifier can either be done by navigating the document manager or looking 
at a specific record.  The document manager is structured exactly the same way as Meridian.  
The classes and subclasses are identical.  If looking at a document in a Unifier record, the 
attachment is under “Attachments” on the right of the screen.  Again, the document can only be 
viewed.  If it needs to be changed, it will need to be downloaded, revised, and then re-uploaded 
as either a revision of the document or a new document.   

About Meridian and Unifier  

Meridian is a document manager that works using meta-data.  Projects are not created in Meridian.  You 
will not see a project in Meridian unless there is a document saved that is associated with a particular 
project.  You can search for Unifier project documents under the UCB number in Meridian.  If you don’t 
see the UCB number (Unifier project) in Meridian, it is because no documents have been filed yet.  There 
is no change to how Meridian functions to accommodate Unifier.  There is, however, a new “Project 
Source” on the Meridian Wizard.  This new project source is “Unifier” so that when a document is put into 
Meridian for a Unifier project, the person filing will select “Unifier” (for Unifier projects) instead of “Capital” 
(for CPs) or “Maintenance” (for PRs).  The other thing of importance is that unless the location has been 
entered into the Unifier project, the Unifier project number will not be available in Meridian.  The is 
because of the interface requirements. 

One thing to note is that the interface between Meridian and Unifier is a one-way interface.  Documents 
will go from the Unifier document manager to Meridian.  Documents will never go from Meridian to Unifier.  
Also, please keep in mind that Meridian is the organization’s approved document manager for retention 
and archival purposes.  All project documents will eventually be in Meridian, even though they may live 
for a time in Unifier. The interface between the two systems is expected to be live by late spring 2020.  
The plan is for the systems to sync overnight, like Meridian and FAMIS do now. 
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1.2.1 VIEWING DOCUMENT STRUCTURE, PERMISSIONS AND CONTROL (UPDATED: 
4/9/2020) 

 

Goals How to view and interact with the document structure. Includes different 
security options and metadata that is available. 

Navigation Project>Document Manager 

Action By All Users 

Pre-requisites Initial project creation.   

Related Files None 
 

Action By: All Users Example 

1. Navigate to Project>Document 
Manager.   

2. A list of standard folders created with 
the template will appear. Standard 
groups and permissions will also 
apply.  

3. Folders have relationships with “sub-
folders” with permission being 
inherited from parent folders by 
default.  

NOTE: Templates and other standard 
documents may be stored at the 
document manager at the UCB level.   

 

4. Search for documents using the 
magnifying glass icon. Search criteria 
includes related processes and any 
metadata associated with the 
document.  

Note: After a document is uploaded to 
document manager, Unifier begins to 
scan the content as well as the file 
name for search capabilities.  
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Action By: All Users Example 

5. To view permissions for a specific 
folder. Select that folder and then 
select Permissions from the right 
panel.  

Note: Permissions can be set by 
those that are enabled by 
permissions. If you don’t have the 
right permissions, please contact your 
Company Administrator.  

 

6. By default, most folders will inherit 
permissions from the parent folder.  

Note: To learn more about copying 
and managing documents, select the 
(?) in the upper right corner next to 
favorites and search for “Copy a 
Document”. 

 

7. Enter the search term “Working with 
Document Manager” to learn key 
features and abilities.  

Note: Clients and Vendors will not 
see the Document Manager, they will 
see those documents they need to 
see via the Business Process. 

 

 
END TASK 
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1.2.2 UPLOADING DOCUMENTS AND NAMING CONVENTIONS (UPDATED: 4/9/2020) 

 

Goals How to use naming conventions in Unifier. 

Navigation Project>Document Manager 

Action By All Users 

Pre-requisites Access to Document Manager   

Related Files None 
 

Action By: All Users Example 

1. Navigate to Project>Document 
Manager and view the folder 
structure.  

Note the folder structure is similar to 
what is in Meridian.  

a. For example, a closeout plan 
should be uploaded to 
Closeout>Closeout Plan.  

Note direct uploads to Unifier should 
support current document 
management naming conventions 
used today e.g. class-sub-class. 

 

2. After ensuring the name is correct, 
navigate to the folder where the 
document should be located.  

3. Select the “Up Arrow” to upload the 
document.  

 

4. Navigate to the location on the folder 
or network where the document is 
stored.  

5. Select “upload” to place the 
document from the computer into 
Unifier.  

Note: Contact your Project 
Coordinator or Project Manager if 
help is needed in understanding 
naming conventions. 
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Action By: All Users Example 

6. Once uploaded, metadata will need to 
be added. To do this, find the 
document that was just uploaded.  

Note: The metadata is needed only 
for documents uploaded directly to 
Unifier as the processes will 
automatically populate this. Metadata 
is used to map the integration into 
Meridian.  

 

7. The Properties screen opens. Enter 
the required “metadata”, or 
information about the document.  

a. File Suffix: Use the Meridian file 
suffix standard.  

b. Other fields are not required or 
are automatically populated. 

8. Select “Save” to save the metadata.  

 

 
END TASK 
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